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Abstract 

Diabetes is a worldwide health issue that has been expanding mainly in developed 
countries. It is characterized by abnormal levels of blood sugar due to several factors. 
The most common are resistance to insulin and the production of defective insulin 
which exerts little or no effect. Its most common symptoms include tissue damage to 
several systems due to elevated levels of blood sugar. One of the key enzymes in 
hydrocarbon metabolism is α-glucosidase (EC 3.2.1.20). It catalyzes the breakdown of 
complex carbohydrates into their respective monomers (glucose) which allows them to 
be absorbed. In this work, caffeoyl quinic acids and their metabolites were analyzed as 
potential inhibitors for α-glucosidase. The search for the best inhibitor was conducted 
using molecular docking. The affinity of each compound was compared to the inhibitor 
present in the crystal structure of the protein. As no inhibitor with a similar affinity was 
found, a new approach was used, in situ drug design. It was not possible to achieve an 
inhibitor capable of competing with the one present in the crystal structure of the 
enzyme, which is also its current commercial inhibitor. It is possible to draw some 
conclusions as to which functional groups interact best with certain residues of the 
active site. 

This work was divided into three main sections. The first section, Diabetes, serves as an 

introduction to what is Diabetes, its symptoms and/or side effects and how caffeoyl 

quinic acids could be used as a treatment. The second section, Caffeoylquinic acids and 

their metabolites as inhibitors for Alfa-glucosidase, corresponds to the search through 

molecular docking of caffeoyl quinic acids as inhibitors for α-glucosidase and what was 

possible to draw from this search. The last section, In situ design of an inhibitor for α-

glucosidase (EC 3.2.1.20), corresponds to the in situ drug design study and what it 

achieved. The representation of each of the molecules used as a ligand can be found in 

the Annexes. 
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Abbreviations and Acronyms 

AD - Alzheimer's Disease, ADT - AutoDock Tools, AMPK - Adenosine Monophosphate-
activated Protein Kinase, AR - Aldose Reductase, CPT - Carnitine Palmitoyltransferase, 
DPP-4 - Dipeptidyl Peptidase-4, G6P - Glucose-6-phosphatase, GA - Genetic Algorithms, 
GIP - Gastric Inhibitory Polypetide, GLP-1 - Glucagon-like Peptide 1, HBV - Hepatitis B 
Virus, HDL - High Density Lipoprotein, HIV - Human Immunodeficiency Virus, IC - 
Incremental Construction, IGT - Impaired Glucose Tolerance, LDL - Low Density 
Lipoprotein, MC - Monte Carlo, MCSS - Multiple Copy Simultaneous Search, MD - 
Molecular Dynamics, QSAR - Quantitative Structure-Activity Relationship 
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Diabetes 

According to the World Health Organization (WHO) [1], 346 million people suffer from 
Diabetes. Although death due to Diabetes occurs mainly in countries with low or 
medium income, highly developed countries have a larger number of citizens who 
suffer from Diabetes or Impaired Glucose Tolerance (IGT).  

The most common types of Diabetes are: Diabetes type 1, Diabetes type 2 and 
Gestational Diabetes [2]. Type 1 Diabetes is the result of an autoimmune disease in 
which the beta cells of the pancreas (insulin producing cells) are destroyed. In type 2 
Diabetes, the insulin production is generally unhindered but, the insulin that is 
produced is either defective (mutated) or the individual has developed a resistance to 
it, making it less effective. Gestational Diabetes is a type of Diabetes that affects 
women only during pregnancy. It also increases the risk of developing type 2 Diabetes 
[2]. Alzheimer's disease is considered in the work of  Monte et al. [3–5] as type 3 
Diabetes. Their work also indicates that the use of Diabetes prescribed medication in 
Alzheimer's patients reversed its effects.  

Approximately 21 million people suffer from type 2 Diabetes and 42 million suffer from 
IGT in the USA [6]. In Japan, approximately 13,5% of the population is affected by 
either type 2 Diabetes or IGT  [7]. In sub-Saharan Africa, Diabetes causes a severe 
burden on the populations [8]. The most affected, are the inhabitants of urban Kenya 
with 12% suffering from type 2 Diabetes and the less affected population is from rural 
Uganda with only 1% suffering from this form of Diabetes.   

Diabetes is characterized by high levels of glucose in the blood stream due to either 
low production of insulin or ineffective insulin. The elevated glucose levels cause 
damage to several organs and systems and have a higher impact in the nervous and 
circulatory systems [1]. 

Kolluru et al. [9], describe the several body systems affected by Diabetes (Figure 1).  
Diabetes makes the host more susceptible to infections, such as tuberculosis and 
pneumonia. Some retro-viral treatments for HIV cause insulin resistance and thus 
increase the chances of developing Diabetes [8]. 

Treatments and Therapeutic targets in Diabetes Treatment 

There are several treatments and therapeutic targets in the treatment of Diabetes.  
These vary according to the type of Diabetes and, if the treatment is intended only for 
Diabetes or if it is also intended for any of the associated medical conditions. The most 
common and cost effective control in Diabetes is monitoring blood pressure and 
glucose and cholesterol levels [7,10,11]. 
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Adenosine monophosphate-activated protein kinase (AMPK) 

AMPK is vital in regulating energy metabolism [12,13]. It affects lipid and carbohydrate 
metabolisms by regulating the fatty acid oxidation, cholesterol synthesis, glucose 
uptake by muscle cells and insulin secretion among other processes.  AMPK is present 
in several organs such as the liver, brain and skeletal muscle. 

Activating AMPK on the liver will inhibit the production of fatty acids and sterols and 
inhibits lipogenesis in adipose tissue [12,13]. The levels of activated AMPK vary 
according to physical activity and, when activated, AMPK increases the glucose uptake 
of skeletal muscle cells [13,14]. AMPK activation also increases nitrous oxide (NO) 
bioactivity, lowers insulin resistance, suppresses the production of radicals and 
reduces inflammation [12]. 

 

Figure 1 - Effects of Diabetes as described by Kolluru et al. [9] 

Glucagon-like Peptide 1(GLP-1) and Gastric Inhibitory Polypetide (GIP)  

Both GLP-1 and GIP are released in response to a meal in the intestines and are 
commonly referred to as incretin hormones.  They are responsible for up to 70% of the 
release of insulin after a meal [15–17].  In type 2 Diabetes, the production of GIP does 
not significantly change but its insulin secretion effect is compromised. On the other 
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hand, GLP-1 secretion is impaired with type 2 Diabetes but its functions are not 
compromised [15]. 

GLP-1 inhibits glucagon secretion, reduces glucose levels in the blood and reduces 
hunger [6,15–19]. Due to its high therapeutic value, GLP-1 receptor agonists or GLP-1 
analogues are used in the treatment of type 2 Diabetes. They generate the same 
response as GLP-1 in patients including weight loss and reduction of accumulated fat 
[15,16,18]. Individuals with lower body weight are less likely to develop type 2 
Diabetes [17]. 

GIP stimulates insulin secretion, reduces body weight and induces the proliferation of 
pancreatic β-cells and prevents their apoptosis [17,20]. A higher number of β-cells has 
a higher chance of producing more insulin. However, the protection from apoptosis 
will lead to the preservation of non functional cells leading to a reduction in insulin 
production. 

The effects of GIP, GLP-1 and GLP-1 receptor agonists or analogues are glucose 
dependant [6,15,21]. They are great therapeutic venues due to their effects and low 
chance of inducing hypoglycemia and are more practical than GLP-1 infusions [19]. 
These are designed to resist inactivation and metabolism through Dipetidyl peptisade-
4 (DPP-4) [15]. 

The common side effects of GLP-1 receptor agonists are: nausea, diarrhea, headaches 
and dizziness [21,22]. The nausea these cause has been linked to the slower gastric 
emptying [21]. No gastrointestinal side effects were observed by Zander et al. [16] 
when administering a 6 week GLP-1 therapy. Mundil et al. [23] recently reviewed the 
side effects of GLP-1 receptor agonists on cardiovascular health. They found that these 
drugs had no adverse effects on cardiovascular health and additionally they reduced 
the risk factors for cardiovascular disease by reducing body weight, systolic blood 
pressure and reduced several biomarkers of cardiovascular disease. 

Marathe et al. [19] suggest the use of GLP-1 receptor agonists in combination with 
insulin. As insulin affects the regulation of blood glucose before meals and GLP-1 
agonists help regulate blood glucose after meals, Marathe et al. [19] stress that this 
would provide a better control of blood glucose levels without aggravated risk for 
hypoglycemia.  

Regarding the safety of GLP-1 therapies, GLP-1 therapies my increase the risk of 
pancreatitis, pancreatic and thyroid cancer [23,24]. A more recent review by Marathe 
et al. [19] indicates that safety studies conducted in humans and monkeys did not 
provide a definite link between pancreatitis or pancreatic and thyroid cancers while of 
GLP-1 therapies. The authors indicated that the different levels of expression of the 
GLP-1 receptors in rats increased their odds of developing thyroid cancer. 

Dipeptidyl peptidase-4(DPP-4) 

DPP-4 is responsible for the metabolism and inactivation of incretin hormones such as 
GLP-1 and GIP [15,22]. Inhibitors for DPP-4 are used in the treatment of Diabetes as an 
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alternative or in conjunction with other drugs [25]. DPP-4 inhibitors are less effective 
than other therapies at lowering blood glucose levels and do not induce weight loss 
[19,21,25]. However, these have a very low chance of inducing hypoglycemia as, their 
effect is glucose dependant [21,22,25]. Their common side effects are: upper 
respiratory tract infections, headaches and inflammation of the nasal passages and 
upper pharynx [21,22]. The higher incidence of infections in patients undergoing DPP-4 
inhibitor therapy has been associated with inhibition of DPP-4 in T cells [22]. Cases of 
pancreatitis have been reported in DPP-4 inhibitor therapy only after the marketing of 
the drug was initiated. Similar cases were not detected during clinical trials [21,22]. 
Reid [21] also indicates that these cases were resolved even with continued therapy of 
DPP-4 inhibitors and concludes that the pancreatitis is unlikely to be a side effect of 
the DPP-4 inhibitor therapy. 

A new candidate for the inhibition of DDP-4 is presented by Parmar et al. [26]. 
Naringin, a flavonoid glucoside, successfully inhibited DPP-4 in silico, in vitro and in 
vivo. Although Parmar et al. [26] indicate that narigin is more effective than sitaglipin 
(a commercial inhibitor of DPP-4) at lowering blood glucose, pancreatic lipid 
peroxidation and of nitrate levels in the pancreas, tests for increased incidence of 
pancreatitis, pancreatic and thyroid cancer (all reported side effects of inhibiting DPP-4 
[27,28]) were not conducted. Parmar et al. [26] conclude their work by stressing that 
despite their encouraging results, drug safety and toxicity tests should be performed 
with naringin before any clinical trial or use of the compound. 

Busek et al. [27] indicate that several DPP-4 substrates promote malignant 
carcinogenesis in the colon and brain. Sun et al. [28] suggest that inhibiting DPP-4 may 
trigger prostate cancer metastasis as the invasive capacity of prostate cancer cells 
becomes enhanced. 

Glucosidases/Glycosidases 

Glucosidases or Glycosidases are enzymes under the category EC 3.2.1. Two common 
targets in this class of enzymes are alpha-amylase (EC 3.2.1.1) and alpha-glucosidase 
(EC 3.2.1.20). Alpha-Amylase catalyzes the hydrolysis of internal alpha-1,4-glucan links 
in polysaccharides containing 3 or more alpha-1,4-linked D-glucose units 
(endohydrolysis) while alpha-glucosidase hydrolyzes terminal non-reducing 1-4 linked 
alpha-glucose residues to release a single alpha-glucose molecule (exohydrolysis). 
Inhibiting either of these enzymes will delay the digestion and absorption of 
carbohydrates [2,29,30] but will generally cause flatulence and diarrhea as the 
carbohydrates that are not absorbed are later fermented [2]. The control over 
carbohydrate digestion and absorption will lead to a lower risk of Diabetes and obesity 
[30]. Inhibitors of these enzymes make up for the first line of defense against Diabetes 
[31] and they may also help in the fight against notorious diseases such as Human 
immunodeficiency virus (HIV), hepatitis B virus (HBV) and cancer [31–33]. In anti-viral 
therapy, inhibiting alpha-glucosidase (EC 3.2.1.20) prevents proper protein folding of 
some glycoproteins [32] and this prevents the proper formation of the viral envelope 
[31,32,34]. 
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Hakamata et al. [31] stress that when designing inhibitors for these enzymes, like all 
other enzymes, researchers must consider substrate specificity and what is target 
organism. Each organism may have different sequences for the same enzyme and, as 
such, inhibitors that are effective in one species may not function in another.  

Despite the existence of several synthetic inhibitors for alpha-amylase and alpha-
glucosidase, the use of functional foods and their components as inhibitors for these 
enzymes is a heavily studied topic in several pieces of literature [2,30,35–39]. 

Davies et al. [40] reviewed the differences  in structure and reaction mechanisms on 
glycosyl hydrolases. Their work is critical when attempting to inhibit or design an 
inhibitor for alpha-amylase and alpha-glucosidase as it describes the structural 
diferences between the active sites of these enzymes. While alpha-amylase has an 
active site with a cleft shape, the active site of alpha-glucosidase is shaped as a crater.  

Although an inhibitor for these two enzymes can be designed under the same 
principles, binding to the active site or binding near to the active site and preventing 
proper interaction with the substrate, there are some key differences in how these 
inhibitions are achieved in each enzyme. An inhibitor for alpha-amylase that binds to 
the active site can bind to part of the cleft or to its entire extension while an inhibitor 
for alpha-glucosidase that is intended to bind to the active site will have a more limited 
space. An inhibitor that prevents the proper interaction of these enzymes by disrupting 
the approach of the substrate to them also has differences between alpha-amylase 
and alpha-glucosidase. While the inhibitor of alpha-amylase can bind to the sides or on 
top of the cleft, the inhibitor of alpha-glucosidase will inevitably have to bind to the 
general area above the pocket. In addition to these types of inhibitors, a third kind can 
be considered, an inhibitor that bind to any other part of the enzyme and 
consequently alters its conformation and thus disrupts the catalytic process.  

The inhibitors were tested and designed in this work under the principle of binding to 
the crater/pocket of the active site of alpha-glucosidase. 

Functional foods 

Foodstuffs are often used to treat Diabetes in folk medicine and with the development 
of new scientific techniques and methodologies their efficiency is put to the test, 
leading to the production of the so-called functional foods. Dembinska-Kiec et al. [41] 
review the risk factors for type 2 Diabetes that can be treated by phytochemicals: 
reduction of oxidative stress, arthrosclerosis, enhancement of glucose and lipid 
metabolism, cytoprotection of β-cells, inhibition of aldose reductase (EC 1.1.1.21), 
improvement of cardiovascular health by promoting vasorelaxation and reduction of 
blood vessel thinness and the control of angiogenesis.  

Souza [37] wrote a thesis on the inhibitory activity of several vegetable species and 
found 29 extracts that inhibited alpha-glucosidase by over 80%. Several studies 
focused on only one or a few plant species have also yielded encouraging results in the 
use of functional foods [42–46]. Marathe et al. [19] indicate that ingesting whey 
protein 30 to 60 minutes before a meal will enhance the release of GLP-1 and insulin. 
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However, promising as they are, so far the studies of functional foods in the treatment 
of Diabetes have been conducted  not using human subjects or human enzymes 
[36,38,42,47].  

Food rich in caffeoylquinic acids and other Hydroxycinnamates, such as coffee, has 
gained significant importance as these compounds have several mechanisms of action 
all relevant for the treatment of Diabetes. These inhibit alpha-glucosidase (EC 3.2.1.20) 
[38,47], stimulate the release of GLP-1, and inhibit the release of GIP [17,35,48]. 
Caffeoylquinic acids inhibit glucose-6-phosphatase (EC 3.1.3.9) [35,39,49–52]. Welsche 
et al. [53] were able to document their blockage of glucose uptake. These compounds 
will also reduce the accumulation of fat and stimulate lipolysis [17,52,54]. Additionally, 
they induce a loss of body weight [52,55] and improve cardiovascular health [56–59]. 

 

Physical Exercise and Diet 

Engaging in mild physical exercise is a common recommendation in the treatment of 
Diabetes [7,10,11,60]. Despite being highly recommended and used in combination 
with other treatment [15],  many diabetics or individuals at risk of developing Diabetes 
still dismiss it [61]. 

One of the major benefits of physical exercise is the activation of AMPK [12,14]. It will 
also reduce risk of developing type 2 Diabetes, obesity and will improve insulin 
sensitivity [6]. 

The purpose of dieting in Diabetic patients is to control energy intake [62]. As the 
reduction of energy intake has to be quite significant, very few patients achieve normal 
values of plasma glucose through dieting alone. The main limitation in dieting is the 
lack of meaningful and lasting results [63]. The success of dieting is limited by patients 
overeating and inability to restrain [64]. On the other hand, the researched performed 
by Clark [63] indicates that restraint will negatively impact quality of life and lead to 
weight fluctuations. 

The control of body weight through exercise is far more effective at providing a higher 
quality of life than attempting to reduce body weight [65]. The best approach to treat 
Diabetes is to diet, exercise and take medicine simultaneously, as patients had higher 
quality of live and enjoyed the benefits of all three approaches simultaneously [66]. 

High blood pressure, cholesterol, glucose and obesity 

Elevated blood pressure, cholesterol, glucose levels and obesity occur very often in 
people suffering from Diabetes. Obesity is quite often present in situations of elevated 
cholesterol and hyperglycemia. 

 

 



Enzymatic inhibitory activity of hydroxycinnamates (HCs). In silico studies 

 

8 

 

High blood pressure 

High blood pressure results from a combination of several factors. One of these is an 
elevated oxidative stress value in the blood stream [10,56]. Ochiai et al. [56],  found 
that when the oxidative stress is reduced with anti-oxidants, such as chlorogenic acid 
(Figure 2) and its metabolites, the amount of radicals that react with NO decreases and 
thus enables it to exert its vasodilation effect.  

 

 

Figure 2 - Chlorogenic acid 

A rigorous blood pressure control has been is effective in preventing Diabetes cardio-
vascular complications, including renal failure, and also reduces the financial burden 
regarding Diabetes treatment [11,58,67]. According to Ochiai et al. [56], ferulic acid 
(Figure 3), one of the metabolites of chlorogenic acid, has a significant hypotensive 
effect (up to 1,4% with 50mg/kg of body weight) when administered alone and an 
enhanced effect when combined with medication to reduce blood pressure, such as 
captopril Although drugs such as captopril and other regulators for blood pressure 
increase the cost of treating patients, the possibility of combining them with 
chlorogenic acid and/or its metabolites offers many theraputic venues. These are 
ingested daily in several foods and beverages such as coffee or apples, making this 
approach very appealing from a therapeutic point of view [46,68]. When blood 
pressure is monitored, heart health is also analyzed. This is usually done using a bio-
marker for heart health, homocysteine. Homocysteine levels rise with high doses 
(2g/day) of chlorogenic acid [60], twice what is usually ingested [68]. Despite proving 
that homocysteine levels increase, it was not proven that this increase was due to 
changes in heart health [60]. Ingesting a low amount of chlorogenic acid significantly 
lowered homocysteine levels (approximately less 2nmol/ml after 4 months on 140mg 
per day) [10]. 

A recent study on the cost of hypertension and obesity on US diabetic patients [69], 
indicates that an obese diabetic has 14% higher health care costs while a diabetic with 
hypertension has 26% more medical costs. Condliffe et al. [69] further explain that 
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diabetics with both hypertension and obesity have 40% higher medical costs and that 
the amount of diabetics with both hypertension and obesity is higher than the amount 
of diabetics with one or neither of these conditions.  

 

Figure 3 - Ferulic Acid 

Elevated Cholesterol, Body fat  

High levels of cholesterol in the blood lead to increased blood pressure and high risk of 
cardio-vascular diseases. Additionally, monitoring cholesterol levels in the blood 
stream is also recommended for diabetics as a way to reduce costs of treatment and 
chances of complications and thus improving quality of life [1,11,52,58]. 

Another useful approach is to reduce fat absorption and/or to enhance lipid 
metabolism. This also leads to a reduction in body weight. One of the ways to enhance 
lipid metabolism is by increasing carnitine palmitoyltransferase (CPT) activity. This 
enzyme is responsible for transporting lipids into mitochondria to be oxidized. Green 
coffee extract which contains, among other compounds, chlorogenic acid and other 
caffeoylquinic acids, was proven to reduce fat accumulation around the liver of mice 
and enhance CPT activity [55]. Two other investigations [10, 67], provide contradictory 
results regarding the changes in cholesterol levels. Those studies had very different 
durations and number of participants. While Tucker et al. [10] analysed only 20 
individuals, they are observed over a period of four months. On the other hand, 
Crozier et al.  [67] studies 117 individuals but for only 28 day. Despite its small sample, 
the results presented by Tucker et al. [10] clearly show that there is a significant 
reduction in the levels of total cholesterol, high density lipoprotein (HDL) and 
phospholipids. The results from Crozier et al. [67] have a major flaw, they are not 
statistically significant because the p value for the levels of triglycerides, total 
cholesterol, HDL cholesterol and LDL cholesterol are all smaller than 0,9. This is due to 
an error in the measurements. The triglycerides values have an error margin of nearly 
± 50%. Johnston et al. [48] present results that concur with the ones obtained by 
Tucker et al. [10]. There is a reduction of body fat accumulation over an extended 
period of time.  

Li et al. [70] have found that a predisposition for obesity increases the risk for type 2 
Diabetes. They were able to establish a link between eight of 12 single-nucleotide 
polymorphisms associated with obesity and risk for type 2 Diabetes, concluding that 
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for each of the Body Mass Index (BMI) increasing allele present, the risk for type 2 
Diabetes increases by 4%. 

Hyperglycemia  

Glucose levels should be monitored in diabetics because, when elevated, they lead to 
most of the complications associated with this disease, specially nerve, kidney and eye 
damage [1]. Monitoring the blood glucose levels has been proven to be cost reducing 
and provide diabetics with better quality of life [1,11,52,58]. There are several ways to 
lower blood glucose levels. The simplest way is through a controlled diet low in 
carbohydrates. Other common approaches are insulin injections and/or through 
medication that controls glucose level by inhibiting its absorption or the catabolism of 
carbohydrates. The insulin therapy proves to be a problem in cases where the patient 
has defective insulin receptors or has insulin resistance. Therefore, it is highly useful to 
have a drug that can regulate blood glucose through several mechanisms.  

Chlorogenic acid is capable of producing changes in the release of intestinal hormones 

[50]. One of the key enzymes in glucose metabolism is glucose-6-phosphatase (G6P). It 

is simultaneously responsible for the first step of the glycolysis and the last step of 

gluconeogenisis by either adding or removing the phosphate group from a glucose 

molecule respectively. As such, inhibiting this enzyme is a great approach to control 

glucose levels. In vitro tests conducted by Salazar-Martinez et al. [71], indicated that 

chlorogenic acid and its isomer (4-caffeoylquinic acid) successfully inhibited G6P by 

9,2±1,4 and 14,4±1,2% respectively. By combining all the analyzed caffeoylquinic acids 

and di-caffeoylquinic acids the authors achieved 34,8±4,0% inhibition. In coffee, it is 

possible to find both caffeoylquinic and di-caffeoylquinic acids (ie: 3,5-dicaffeoylquinic 

acid,  
Figure 4). Long term coffee consumption significantly lowers the risk for type 2 
Diabetes [17]. This was observed in both decaffeinated and caffeinated coffee 
consumers, despite short term studies indicating that caffeine decreases insulin 
effectiveness. Chlorogenic acid alters glucose absorption in the intestines by inhibiting 
it's uptake [20,50]. Chlorogenic acid reduced the release of Glucose-dependent 
insulinotropic polypeptide (GIP) and increased the release of Glucagon-like peptide 1 
(GLP-1) [50]. GIP induces β-cell proliferation and protects them from apoptosis. 
Although it is useful that β-cells proliferate, as they are protected from apoptosis they 
waste resources and do not produce insulin as expected [16,17,20]. 

GLP-1 has many functions [6,15–18]. The work of Araki et al. [72] analyzes the effects 
of GLP-1 over six weeks on type 2 diabetics. They found that GLP-1 was capable of 
reducing glucose levels (both fasting and average), glycated hemoglobin and free fatty 
acids (fasting and average as well), increased insulin sensitivity and β-cell function. 
GLP-1 also caused a reduction in appetite and caused a weight loss of almost 2kg.  
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Figure 4 - 3,5-Dicaffeoylquinic Acid 

Diabetic Nephropathy 

Between 10 to 20% of diabetics die from renal failure [1]. As such, it is imperative to 
monitor the risk for nephropathy in all diabetics [1,11,52,58]. This may prevent renal 
damage, reduce odds of complications and will cut treatment costs. The risk factors for 
nephropathy are usually exhibited by all diabetics [73–75]. These include: 
hypertension, poor control of blood glucose and aging. Retinopathy is also one of the 
symptoms for diabetic kidney failure [75]. 

Although there are very few studies that analyze the effects of chlorogenic acid on 
diabetic nephropathy, the fact that this compound can control and reduce the risk 
factors for it, make it relevant in the treatment of diabetic kidney damage. 
Furthermore, the fact that there is an international patent, submitted by Alexiadou et 
al. [76], that uses chlorogenic acid as a treatment for diabetic nephropathy 
demonstrates its potential application as a therapy for Diabetes. Age is also one of the 
key risk factors for kidney failure in diabetics [73–75]. Since the aging process is sped 
up by increased oxidative stress, which can also be one of the causes for Diabetes, the 
anti-oxidant properties of chlorogenic acid make it an even greater asset in treating 
this condition by regulating the oxidative processes.  

Ulcers and lower limb damage 

Diabetic foot ulcers occur due to a reduced blood flow and neuropathy [1,77]. Despite 
receiving appropriate treatment, quite often diabetic ulcers fail to heal [78]. These 
ulcers are the result of a persistent bacterial infection that, with reduced blood flow 
and sensitivity, is sheltered from self examination and from the immune system.  

The most common genera and species of bacteria found in diabetic ulcers, as 
described by Almeida et al.l [79], include the Streptococcus, Staphylococcus, 
Pseudomonas and Eschericia genera. These are some of the bacteria genera that are 
vulnerable to chlorogenic acid [80]. Additionally, quinic acid (Figure 5), which results 
from the first step of the catabolism of chlorogenic acid, enhances DNA repair 
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mechanisms and boosts the immune system of its consumers [81]. Almeida et al. [79] 
recommend the use of antimicrobial films to dress wounds as a viable treatment for 
diabetic ulcers. Diabetic patients should be screened and treated for depression, if 
applicable, as diabetics with depression are twice as likely to develop ulcers and have a 
higher chance of complication [82]. As diabetic ulcers result from the combination of 
reduced blood flow and neuropathy, cholorogenic acid is clearly useful. In addition to 
its anti-bacterial and immune system boosting capabilities, it also affects blood flow 
and has neurological effects. The effects of chlorogenic acid on blood flow were 
previously described on the topic entitled “High blood pressure, cholesterol, glucose 
and obesity” and its neurological effects are described further ahead in the chapter 
“Diabetic neuropathy”. 

 

Figure 5 - Quinic Acid 

Diabetic retinopathy 

After having Diabetes for 15 years, 2% of patients become blind and 10% are visually 
impaired [1]. These numbers are consistent to those reported by Hall et al. [8], where 
retinopathy ranged from 7 to 66% depending on the country. South Africa is the 
country with the highest number of studies for retinopathy [8] and in all the analyzed 
study cases, the prevalence of retinopathy is extremely high, >32%. Monitoring of 
retinopathy is recommended as a way to reduce costs and improve quality of life of 
diabetics [1]. Frequent monitoring of retinopathy (at least once a year) has been 
shown to be cost saving by several model studies. [58] Diabetic retinopathy, is the 
result of an elevated oxidative stress that results from the reduction of glucose to 
sorbitol through aldose reductase (AR) (EC 1.1.1.21) [83,84]. The accumulation of 
sorbitol in the retina also leads to diabetic cataracts [83]. 

There are several inhibitors for AR from natural products and one of these is 
chlorogenic acid. It is capable of inhibiting AR function and, its anti-oxidant properties 
counter the increased oxidative stress produced [82]. Therefore, chlorogenic acid is 
capable of treating and preventing damage to the eyes that results from excessive AR 
activity which will usually lead to diabetic cataracts [83]. 

In addition to the oxidative stress that is a result from elevated AR activity, diabetics 
with retinopathy also exhibit elevated lipid peroxidation, protein oxidation and DNA 
damage due to oxidative stress [84]. The most important risk factors for type 2 
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diabetics, associated with developing diabetic retinopathy, are elevated glycated 
hemoglobin, elevated blood pressure, high body mass index and length of time that 
the patients suffer from Diabetes [85,86]. Type 1 Diabetes patients, retinopathy has 
almost 100% prevalence and as such what is analyzed are the risk factors for 
proliferative retinopathy.  The risk factors are elevated levels of glycated hemoglobin 
and the presence of non-proliferative retinopathy. Blood pressure, body mass index 
and duration of Diabetes are not considered risk factors for type 1 diabetics [87]. 

Diabetic neuropathy 

Up to 50% of diabetics suffer from diabetic neuropathy [1]. In Sub Saharan Africa, 
neuropathy affects 27 to 66% of diabetics [8] and in a 12 year follow-up study 
conducted in India it was found that neuropathy affected between 35,3% of the 
subjects with normal renal function and 68,7% of individuals with compromised renal 
function. [75] In Sweden, peripheral neuropathy affected 67% of diabetics [88]. In 
Singapore, neuropathy rates vary with duration of Diabetes from 34,1 to 72,4% for less 
than five years and over 10 years of Diabetes, respectively [3]. The best diagnostics 
method for peripheral neuropathy is using a neurometer as opposed to the more usual 
methods, the pinprick test and the Semmes-Weinstein Monofilament Testing (SWMT). 
However, despite being less accurate, the pinprick test is still a low cost and reliable 
diagnostics method for peripheral neuropathy [3]. 

Alzheimer's disease (AD) is a result of a large number of factors and over the past few 
years it has been proposed and coined as type 3 Diabetes [3–5]. A large number of 
factors lead to neural degeneration and the most important are: elevated oxidative 
stress, DNA damage, lipid peroxidation, and insulin resistance [4,5,89]. DNA damage 
and lipid peroxidation are both present in diabetics due to elevated glucose levels [83]. 
The degeneration caused by AD can be reversed through medication used in type 2 
Diabetes due to an increase in insulin efficiency and reduced oxidative stress [4]. 
Chlorogenic acid is highly neuroprotective against elevated oxidative stress and 
amnesia [90,91]. Both these conditions are symptoms of AD. Some researchers claim 
that AD is a form of Diabetes that affects the brain specifically and an increase of 
insulin production and/or efficiency would be able to treat and even reverse the 
damage that occurs with AD [4,5,89]. 

In this manner, chlorogenic acid proves once again to be extremely useful as it is 
capable of both improving insulin production and sensitivity [17,20,50,71]. Chlorogenic 
acid reversed the impairments that were induced in mice and also improved their 
short term memory [90]. It has been proposed that the increased incidence of 
Diabetes type 1, 2 and 3 is due to an increasing exposure to nitrates, nitrites and 
nitrosamines through several sources but mainly through the elevated consumption of 
processed foods in which these compounds are used as preservatives. This also helps 
to explain the elevated prevalence of Diabetes in developed countries [91]. 
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Diabetes compendium 

Considering all the literature reviewed so far, we show that chlorogenic acid and other 
caffeoylquinic acids are highly bioactive in the treatment of Diabetes. It is also shown 
that their exerted effects are highly useful while treating Diabetes and/or conditions 
associated with it. As such, we believe that the use of chlorogenic acid and other 
caffeoylquinic acids or green coffee bean extract, very rich in these, should be 
considered while treating Diabetes and associated diseases, even if just as a 
supplement to regular treatments.  
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Caffeoylquinic acids and their metabolites as inhibitors for Alfa-
glucosidase 

Literature on the metabolism of Caffeoylquinic and Dicaffeoylquinic acids has 
increased in recent years. Although still limited, the development of novel techniques 
and methods in analytical chemistry has jump started the amount of information 
available. The production of caffeoylquinic acids and dicaffeoylquinic acids can be 
induced or enhanced in artichoke by irradiation with UV-c radiation [92]. In other plant 
species, wounding or irradiation with UV-b increased the production of chlorogenic 
acid (5-O-caffeoylquinic acid, 5-CQA).  

Although a higher concentration of caffeoylquinic acids would benefit the consumer, it 
is necessary to consider that understanding their bioavailability and absorption are 
crucial for their use in medicinal applications.  

Most of the literature that studies the effects of caffeoylquinic acids is performed in 
vivo and the effects produced are not compared to the effects caused by the 
administration of the known metabolites of these compounds.  

As such, the hypothesis that caffeoylquinic acids might be used as enzymatic inhibitors 
has been tested. The hypothesis that the effects often observed in vivo could be 
generated by the presence of the metabolites and not the caffeoylquinic acid itself was 
also tested. Considering this, the literature was analyzed for information on 
caffeoylquinic acids and dicaffeoylquinic acids’ metabolism and absorption. Then, 
these compounds and some designed derivatives along with their metabolites were 
tested as inhibitors of α-glucosidase (EC 3.2.1.20) through molecular docking using the 
crystal structure resolved by Ren et al. [93] for the enzyme. 

Absorption 

The absorption of caffeoylquinic acids has been established to occur in the intestines. 
This was shown mainly by the recovery of undigested caffeoylquinic acids from the 
stomach, even post-mortem [94]. A study simulating the digestive process on several 
polyphenols and also reached the same conclusion by recovering the caffeoylquinic 
and caffeic acid (Figure 6) portions nearly intact from the simulated gastric juice [95].  
The metabolism of caffeoylquinic acids starts at the duodenum with the cleavage of 
the ester bond between caffeic and quinic acids accounting for 37% of the initial 
amount of caffeoylquinic acids [95]. Lafay et al. [96], found that, in the small intestine, 
a small amount of 5-CQA (approximately 10%) is metabolized to caffeic acid and its 
conjugates. In an older study, Azuma et al. [97] state that the small intestine may not 
be the place where the ester bond is cleaved. According to Crozier et al. [67], the small 
intestine still plays an important part in the absorption of chlorogenic acids. These are 
absorbed in a significant amount (30%) in the small intestine and the remaining acids 
are absorbed in the colon. This is also confirmed by the difference between the 
amount of chlorogenic acids excreted in the urine, with ileostomists excreting nearly 
four times less than subjects with a colon [67]. 
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Caffeoyl and dicaffeoylquinic acids appear to have different absorption mechanisms, 
as the ratio in which both were detected was different from the ratio in which they 
had been ingested [98]. This difference may be due to the increased hydrophobicity of 
dicaffeoylquinic acids allowing them to cross the cellular membranes through 
diffusion. 

 

Figure 6 - Caffeic Acid 

Metabolism 

The colon is not only the prime site for the absorption of chlorogenic acids but also for 
their metabolism as the main reactions occur in this area [67,99]. Part of the 
metabolism of these acids also occurs in the liver. This was confirmed with in vitro 
tests, even if in a less extensive manner [95]. 

Metabolism of chlorogenic acids consists of the breaking of the ester bond between 
the quinic acid and the hydroxycinnamic acid, followed by methylation, the 
conjugation of the hydroxycinnamic acid with sulfates, glucuronides and or the 
saturation of the double bond in the C3 chain of the acid [67,98–100]. 

The main reactions, the places where they occur, the intervening enzymes and their 
products are described in detail in Figure 7. It is the metabolism for chlorogenic acids 
proposed by Crozier et al. [67]. It was designed considering the experimental results 
from the digestion of coffee by human volunteers. 
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Figure 7 - Metabolism for chlorogenic acid proposed by Crozier et al. [67];  COMT, catechol-O- methyltransferase; 
ET, esterase; RA, reductase; GT, UDP-glucuronyltransferase; ST, sulfuryltransferase; Co-A, co-enzyme A. Bold 
arrows indicate major routes, dotted arrows minor pathways 
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Molecular docking 

Molecular docking was created in the early 1980's by Kuntz et al. [101].  As it is 
explained by Meng et al. [102], the aim of molecular docking is to predict the 
interaction between two molecules, the ligand and the receptor. Its ultimate goal is to 
find the most stable conformation between the two molecules [103]. Molecular 
docking has been successful to identify binding mechanisms, it has explained 
experimental results and has been able to identify binding sites of new molecular 
targets [104]. 

 Molecular docking is performed in two steps. Firstly, conformations of the ligand 
interacting with the receptor are generated resorting to one of several algorithms. 
These resort to empirical  force fields [103]. Meng et al. [102], refer that they use 
different search methods. Once the conformations are generated, they are then 
scored and ranked using Scoring Functions [102,104]. 

Molecular docking algorithms 

As said by Meng et al. [102], matching algorithms (MA) represent both the ligand and 
the receptor as pharmacophores. These are described by Wermuth et al. [105] as "an 
ensemble of steric and electronic features that is necessary to ensure the optimal 
supramolecular interactions with a specific biological target and to trigger (or block) its 
biological response". As such, pharmacophores do not represent molecules but instead 
the features that are present in a group of compounds and that allow them to interact 
with their target. MA are fast and most useful when improving a set of compounds 
with an already established effect [102]. 

Incremental construction (IC) and Multiple Copy Simultaneous Search (MCSS) are 
fragment-based methods. These divide the ligand into small fragments that are placed 
in the active site (or docking target) in an incremental fashion. Although both methods 
are fragment-based, their approach is quite distinct. IC fits the biggest fragment of the 
ligand in the docking site and adds the remaining fragments one by one and 
orientations are generated for each fragment to best describe the ligand flexibility and 
interaction in the docking site. MCSS, on the other hand, generates thousands of 
copies of each functional group and randomly places them in the target site. These are 
then subjected to energy minimization and limited by force fields. To obtain a new 
molecule that is complementary to the target site, all that is required is to link the best 
ranking functional groups in their proper conformation [102]. 

Stochastic methods randomize the ligand's conformation in the docking site [102]. Two 
common algorithms that employ stochastic methods are Monte Carlo (MC) and 
Genetic Algorithms (GA). MC algorithms generate conformations of the ligand by 
rotating bonds and by rotating and translating the ligand as a rigid body. Once a 
conformation is generated, it is then compared to the criteria established and, if it fits 
these criteria, it is saved and improved until the number of desired conformations is 
achieved. The fact that MC results are not deterministic, is both its best and worse 
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feature. This may generate a set of results that only meet the minimum requirements 
established or it may generate outstanding results that otherwise would be very hard 
to achieve. GA are based on theory of evolution. Degrees of freedom are considered as 
genes that make up a chromosome, the ligand's conformation. Like regular genes, 
these can be affected by mutation (that randomly change the genes) and by crossover 
(that exchanges "genes" between conformations). After mutation and crossover each 
conformation is subjected to a fitness test (scoring function) and, if they survive 
(overcome an energy threshold) they will be used on the next generation. Although GA 
are non deterministic like MC methods, GA benefit from the mutation and crossover 
mechanisms.  

Molecular Dynamics (MD) simulates the movement of each atom individually. It is 
limited by the fact that it advances in small steps but it is quite efficient at local 
optimization. As such, it is most effective when used after a random search has been 
conducted. While the random search will find a local energy minimum, MD will then 
optimize it and provide even better results [102]. 

Molecular docking: Scoring and validation of results  

The success of docking is determined by the ability to discriminate between correct 
and incorrect conformations and by the ability to properly rank the produced 
conformations [102–104]. 

There are several kinds of scoring functions such as: Empirical functions [102,106], 
Molecular/Quantum mechanics functions [102,103,106], Knowledge based functions 
[102,107] and Consensus scoring [102,103,106,107]. Some functions also consider 
important factors in molecular mechanics like Entropy and Solvation [103,106]. 

Entropy is a key factor in binding energy. Due to its high difficulty to calculate, it is only 
accounted for in specialized scoring functions and functions with extension of force-
fields [102,103,106]. 

Solvation is another factor that is often omitted or simplified in the scoring process. 
This is due to the many degrees of freedom that it implies. It is mainly considered by 
knowledge based functions but still most models do not consider the effects that 
solvent molecules would exert on the receptor, ligand and their interaction in the 
binding site [103,106]. 

Empirical functions are created by combining experimental data and parts of other 
already established functions. Their greatest feature is simplicity but it often limits the 
accuracy of the results that these functions provide [102,106,107]. 

Molecular/Quantum mechanics functions resort to force fields and quantum 
mechanics to describe the binding of the ligand to the receptor. These consider 
hydrogen bonds, solvation, entropy and Van der Waals interactions [102,103,106,107]. 

Knowledge based functions are based on statistical methods. These are based on the 
consideration that the best interactions are the most statistically common. Despite 
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being able to provide insight into uncommon interactions, they are very limited by 
their training set that often does not properly represent all interactions [102,107]. 

Consensus functions are usually used to improve docking results. With consensus 
functions, several scoring functions are combined [102,103,106]. These functions 
operate under a similar principal to knowledge based functions. As such, they assume 
that the best ligands will have consistent performances with several methods and thus 
the ligands that score better through the array of tests will likely have a better 
experimental affinity. Although consensus functions are thought to provide one of the 
best solutions to achieve better results, they are still very limited by the scoring 
functions at their core [102,103,106,107]. 

In a review about the accuracy of docking results from seven popular docking 
programs and their respective experimental results, Augustyniak et al. [107] ranked 
Autodock  (created by Morris et al. [108]) at the bottom of the table. This was based 
on the RMSD  value of the docked ligands . Despite this, Autodock still achieved a 50% 
of correct pose prediction. Autodock is still one of the most popular programs due to 
its simplicity and ease of use, mainly due to its Graphical user interface [104]. Despite 
having been published recently, these two studies do not take Autodock Vina (Vina - 
created by Trott et al.[109]) into account. Vina can be considered as the second 
generation of Autodock and it offers great increases in speed, accuracy and supports 
multi-core computing.  

A review comparing the results obtained with Autodock4 and with Vina authenticates 
the improvements of Vina relating to Autodock4 [110]. As such it is established that 
not only does Autodock Vina execute tasks faster, it is also produces more accurate 
results when compared with Autodock4. Despite the fact that both programs suffer 
from size bias, Vina is better at accurately ranking larger molecules.   

As such, considering the vast improvements of Autodock Vina over Autodock 4, its 
similarities in use and, previous experience with Autodock 4, Vina was chosen to 
perform all the docking operations in this work. 

Molecules used on the docking 

As it was referenced previously, on the initial stage of this work, (di)caffeoylquinic 
acids, generated derivatives and metabolites were used as enzymatic inhibitors. The 
metabolites are the molecules identified as Inib22 up to and including Inib35 (Annex 
22 to Annex 35 respectively). The naturally occurring compounds are the molecules 
identified as: Inib1, Inib2, Inib4, Inib5, Inib8 and Inib10 (Annex 1, Annex 2, Annex 4, 
Annex 5, Annex 8 and Annex 10 respectively). The derivate molecules are the 
molecules identified as: Inib3, Inib6, Inib7, Inib9 (Annex 3, Annex 6, Annex 7, Annex 9) 
and, Inib11 up to and including Inib21 (Annex 11 to Annex 21 respectively). The 
Molecules identified as "Opt" are also considered derivative molecules (Annex 36 to 
Annex 56). 
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Methods 

The chlorogenic acids and metabolites where designed in HyperChem 8.0 [111], 
optimized using MM+ force field, until the RMS gradient was 0,01 kcal/mol or lower,  
and saved as .hin. All the files were then converted to .pbd through OpenBabel [112] 
and opened with AutoDock Tools (ADT) [113]. After opening the files on ADT, the 
Gasteiger charge was computed (“Edit -> Charges -> Compute Gasteiger”) and the 
atoms where assigned as AD4 type (“Edit -> Atoms -> Assign AD4 type”). After these 
two steps each molecule was saved as .pdbqt. After being saved as .pdbqt, each 
inhibitor file was then imported to ADT in the Ligand menu (“Ligand -> Input -> Open”). 
Then, the rotatable bonds where defined (“Ligand -> Torsion Tree -> Detect Root”), 
(“Ligand -> Torsion Tree -> Choose Torsions -> Done”) and (“Ligand -> Torsion Tree -> 
Set Number of Torsions -> Fewest atoms -> Dismiss”).  

As for the receptor, human alpha-glucosidase (EC 3.2.1.20), the .pdb file was 
downloaded from the pdb database (PDB ID: 3TOP). As the receptor is a symmetric 
dimmer, the B chain of the receptor was deleted and only chain A was used in the 
dockings. The water molecules in the ligand in the file were then deleted and the 
receptor file was saved to .pdbqt in the same manner as the chlorogenic acids. Unlike 
the inhibitors, however, hydrogen atoms were added (“Edit -> Hydrogens -> Add -> All 
Hydrogens -> noBondOrder -> yes -> OK”) to the receptor as these are lacking in .pdb 
files of proteins. 

The Molecular Docking was performed using Vina [109]. The Vina box was set at -
31,426; 35,7; 26.325 (x; y; z), with size 35 Å in all axes (x; y; z) and the exhaustiveness 
value was set to “20”. 

The docking results output by Vina were then analyzed both through ADT and PyMOL 
[114]. In ADT, to analyze a docking result the Vina output was opened (“Analyze -> 
Dockings -> Open AutoDock vina result -> Single Molecule with multiple conformations 
-> OK”), the receptor file was opened (“Analyze -> Macromolecule -> Open”) and the 
interactions between both were shown (“Analyze -> Dockings -> Show Interactions”). 
On Windows, to ensure memory is not an issue, all atoms further than 10Å from the 
ligand were deleted. Such action was not necessary while working on linux OS (Ubuntu 
12.04 distribution). To display the interactions between ligand and receptor through 
PyMOL both the receptor and the Vina output were opened in PyMOL (“File -> Open”). 
Then the polar interactions were displayed (“Action -> preset -> ligands”) and the 
residues that established the interactions were identified. 
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Results from in silico study 

Some Hydrogen bonds between the ligand and the receptor couldn’t be detected in 
ADT but where detected in PyMOL. On the other hand, ADT was capable of detecting 
close contacts and π – π stacking that PyMOL could not. This may be due to the way 
Vina treats hydroxyl groups in docking. The hydroxyl groups in some cases formed an 
angle that was not recognized as an Hydrogen bond that could be established between 
the donor and acceptor of the bond. PyMOL’s detection of polar interaction was not as 
constrained, unlike ADT’s, and as such detected all the possible H-bonds and polar 
interactions. 

Of the total 35 inhibitors tested, the top five regarding the affinity towards the target 
were Inhibitors 5, 7, 2, 1 and 8 (Annex 5, Annex 7, Annex 2, Annex 1 and Annex 8 
respectively), the last two having an equal value of affinity (Graph 1). 

Inhibitor 5 (best docked conformation in Figure 8) was then analyzed to see what 
reactions would be possible to perform in order to reduce polarity but maintaining a 
similar structure. This transformation was intended to enhance the amount of inhibitor 
that is absorbed through passive transport in the intestinal wall without significantly 
altering the function and or metabolism of the compound. This would prevent the 
compounds from reaching the intestinal esterases that would break the ester bond 
between the quinic acid and the hydroxycinnamic acid moieties. 

  

Figure 8 - Inhibitor 5's best docked conformation (orange line indicates π-π stacking and dashed green lines 
indicate H-bonds and or electrostatic interactions) the aromatic ring that is stacked with Phe1560 corresponds to 
the branch from position 3' of Quinic Acid 

The optimized inhibitors (Annex 36 to Annex 56) were: an ester at the carboxylic acid 
functional group of the quinic acid moiety (aliphatic chain with one to eight carbon 
atoms in length), an inhibitor in which the double bond between the carboxylic acid 
group and the aromatic ring was converted to a single bond (verified for each caffeic 
acid moiety), and the transformation of the hydroxyl groups of each aromatic ring to 
dioxolanes (verified for each caffeic acid moiety and for both simultaneously). The 
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affinity of these optimizations can be found in Graph 2. Out of this set of inhibitors the 
best performing was the inhibitor in which both diphenols had been converted to 
dioxolanes (Figure 9), its affinity was 0,1 kcal/mol better than inhibitor 5. The 
optimized inhibitors are composed by two generations, the first that includes 
Optimization 1 to 13 and the second generation that encompasses Optimization 14 to 
21. The goal of the first generation was to establish what modifications were the most 
beneficial while on the second generation the goal was to see the effect of extending 
the lipophilicity on the best optimization from generation one. 

 

Figure 9 - Optimization 11's best docked conformation (orange line indicates π-π stacking or π-σ interactions and 
dashed green lines indicate H-bonds) the aromatic ring that is stacked with Phe1560 corresponds to the branch 
from position 5 of Quinic Acid 

The docking for each optimized ligand was ran while moving the most and the fewest 
possible atoms (defined through the file preparation in ADT). In both cases the affinity 
calculated by Vina was the same but when observing the conformations produced in 
the output the conformations where slightly different. The positions of the atoms were 
close in both conformations but they varied on the rotation of the hydroxyl groups. 
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Graph 1 - Affinity of caffeoyl quinic acids and their metabolites and affinity of Acarbose (in green) 

To determine if this variation in the conformation was due to the different amount of 
movable atoms or due to the different algorithm seeds, a cross-over test was 
conducted. In this test, the docking was ran on an inhibitor while moving the fewest 
amount of atoms possible and using the seed for the same inhibitor used to run the 
docking with the most movable atoms. The results from the test indicate that a 
variation in either the algorithm seed or the number of movable atoms produces 
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identical results. The geometrical placement of the atoms was always very similar and 
the variation was mostly noticeable in the rotation of the hydroxyl groups. 

 

Graph 2 - Affinity of each optimized inhibitor, 1st generation: Opt1 to Opt13; 2nd generation: Opt14 to Opt21 and 
affinity of Acarbose (in green) 

The docking of Acarbose was also performed as a control. The docking of acarbose was 
done in four different methods: using the same conformation that it exhibits in the 
crystal structure (with a search box of the same size used for all the inhibitors and a 
search box in which the x size was set to “20”, ran with fewest and most movable 
atoms) and with a random conformation of acarbose produced in HyperChem. None of 
these dockings provided a conformation of Acarbose similar to the one present in the 
crystal structure. The affinity values for these conformations of Acarbose were: -6,8 
kcal/mol for the docking of the random conformation, -8,8 kca/mol for the docking 
with the search box the same size as the other inhibitors and -8,5 kcal/mol for the 
docking with the smaller search box, for both fewest and most movable atoms. These 
ligands were named as "acarb" (ligand with search box of the same size), "acarb2" and 
"acarb3" (ligands with smaller search box) and "control4" (ligand with random 
conformation) (Figure 10). 
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Figure 10 - Conformations of "acarb" (red), "acarb2" (green), "acarb3" (blue), "control4" (cyan) and crystal  
structure conformation (magenta) 

As none of these dockings resulted in the same conformation as the one in the crystal 
structure, a final control docking was performed where the search box was the same 
size as it was for the inhibitors but the ligand had no rotatable bonds (named 
"acarb4"). The conformation produced by this docking (Figure 11) had an elevated 
affinity (-15,6kcal/mol) being  -5 kcal/mol better than inhibitor 5 and -4,9 kcal/mol 
better than the best optimization of inhibitor 5 which consisted on the conversion of 
both diphenols to dioxanes. Figure 12 is a molecular representation of Acarbose. It 
provides information on functional groups that is not represented in Figure 10 or 
Figure 11 in order to simplify the interpretation of the docking results. 
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Figure 11 - Conformation of "acarb" (red), crystal  structure conformation (magenta) and "acarb4" (yellow) 

 

 

Figure 12 - Acarbose 
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Results from in vitro tests 

There are a few studies that analyze the effects of caffeoylquinic acids on α-
glucosidase through in vitro essays. These provide simultaneously insights into the 
inhibition mechanism and a way to confirm and compare the results obtained through 
the in silico study. 

When analyzing the effects of flower buds of Tussilago farfara and their main 
components, as inhibitors for α-glucosidase, Gao et al. [115] reached a few key 
conclusions. They were able to determine that 3,4-Dicaffeoylquinic acid along with 3,5-
Dicaffeoylquinic acid and 4,5-Dicaffeoylquinic acid inhibited α-glucosidase but did not 
inhibit sucrase, isomaltase or a-amylase. In addition, their results show that quinic 
acid, caffeic acid and chlorogenic acids perform poorly as inhibitors for α-glucosidase 
and that the 3,4; 3,5 and 4,5 Dicaffeoylquinic acids moderately inhibit α-glucosidase 
(62-65%) . These results corroborate the results obtained by molecular docking. 

Ooi et al. [47], also analyzed the inhibition of α-glucosidase using 3,4-Dicaffeoylquinic 
acid. Their results indicate that 3,4-Dicaffeoylquinic acid is 30 times less effective as a 
specific α-glucosiadase inhibitor than acarbose. As such they conclude that the 
inhibitory effect is most like caused by its antioxidant properties.  

Ma et al. [39], compared the effectiveness of several ketal and diketal derivates of 
chlorogenic acid shows that long alkyl chains provide better inhibition than the 
compounds with shorter alkyl chains. Despite the fact that these inhibitors did not 
perform as well as Acarbose, it is still possible to draw the conclusion that a lower 
polarity will provide a better inhibition of α-glucosidase. When compared to Acarbose, 
these had one third of its inhibition efficiency. A more recent study, used the results of 
Ma et al. [39] and performed a QSAR study [116]. The analysis performed by Yuriev et 
al. [106] identified a few key requirements for these α-glucosidase inhibitors such as: 
having equal hydrophobic and hydrophilic features at the center of mass and being 
hydrophobic on the molecular surface. Yuriev et al. [116] also conclude that the 
presence of the hydrophobic chains reduces the amount of energy to interact as an 
inhibitor. This occurs since the interaction with water molecules is reduced. 

Sakulnarmrat et al. [117], studied the inhibitory effects of several Australian plant 
extracts on α-glucosidase. The extract of Tasmannia pepper leaf is mainly composed of 
chlorogenic acid and did not perform as well as Anise myrtle or Lemon myrtle. Anise 
myrtle extract was found to contain myricetin, quercetin and catechin while the Lemon 
myrtle extract contained hesperetin, myricetin, and quercetin. The main compounds in 
the extracts of these two plants were Ellagic acid and its derivatives. Only the extracts 
of plants were analyzed and not their individual or main compounds.  

Discussion 

Considering the results obtained, it’s clear that hydroxycinnamic acids namely 
caffeoylquinic and dicaffeoylquinic acids have the potential to bind to the active site of 
human α-glucosidase’s (EC 3.2.1.20) C terminal chain in a similar way as Acarbose, its 
commercial inhibitor. It is important to notice, however, that the affinity of the 
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compounds studied in this work is lower than acarbose by approximately 30%. We also 
established that the metabolites of caffeoyl quinic acids are not suitable inhibitors for 
α-glucosidase. 

Despite having a lower affinity in silico, in vitro tests should be ran in order to establish 
if the difference in affinity is as big as the dockings indicate. Also the other effects that 
(di)caffeoyl quinic acids can exert in the human organism should be considered and 
weighted against its lower affinity, as these “side effects” could in fact help achieve a 
way to treat Diabetes and or its symptoms. 

The results of this study also provide insight in order to develop a new inhibitor of α-
glucosidase considering the structures of the inhibitors tested and the nature of the 
interactions that they establish with the active site of the enzyme. The most suitable 
method to achieve this goal might be in situ design of the drug. 
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In situ design of an inhibitor for α-glucosidase (EC 3.2.1.20) 

The objective was always to create a ligand that had an affinity value close to the one 
that was calculated for acarbose (-15,6kcal/mol). To achieve this, interactions between 
opposing charges with charged functional groups ([R-NH3]+; [R=NH2]+ and [COO]-) and 
favoring π-π orbital stacking from aromatic rings was imperative. The affinity of all the 
inhibitors designed in situ can be found in Graph 3 and a representation of each 
molecule can be found in the Annexes from Annex 57 to Annex 143. 

The first inhibitor designed was very bulky and was expected to interact with a lot of 
residues which was not what resulted from the docking. So, the idea of starting from a 
big ligand was abandoned and the design process focused on starting with smaller 
ligands and optimizing them to increase the number of interactions and improving 
overall affinity. The smaller ligands initially proved difficult to improve as due to their 
small size the best conformations usually were docked outside of the active site. As 
there was always at least one conformation within the active site it was still possible to 
introduce modifications intended to improve the binding of the ligand. The will to 
achieve a better ligand led to the modification of several functional groups from one 
ligand to the other. This led sometimes to ligands whose binding was far from the 
expected and in some cases with an affinity  far lower than the originating molecule.  

Throughout the development of the several ligands, the residues Asp1157, Arg1510 
and Asp1526 were regarded as guiding residues. Their unique positions (Figure 13) and 
the fact that they possess alternating opposite charges makes it possible to "easily" 
fashion a complementary branch in the ligand and ensure the binding of it to the active 
site.  

 

Figure 13 - Charged residues used as targeting guides 

The residue Phe1560 was also used as a guiding residue. However, using aromatic residues as 
a guide significantly increased the size of ligand. The π-π stacking between the ligand and 
Phe1560 sometimes did not occur because the stacking occurred between the ligand and 
Trp1369.  
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Graph 3 - Affinity of each inhibitor designed in situ and affinity of Acarbose (in green) 
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In ligands with more than one aromatic ring, the binding was sometimes similar with 
the binding of the dicaffeoyl quinic acids with one aromatic ring inside the pocket and 
the other stacking with Phe1560. Alternatively, some ligands stacked with both 
Phe1560 and Trp1369. The spatial placement of these residues within the active site is 
represented in Figure 14. 

 

Figure 14 - Residues Asp1157, Trp1369, Asp1526 and Phe1560 within the active site 

The aromatic ring also proved to be an extraordinary way to interact with residues that 
were close to each other but also with residues that are extremely far apart. The 
carbon atom of the carboxyl side chain groups from Asp1279 and Asp1526 are 10.3 Å 
apart but with a ligand with a 1,2-diamine benzene ring the ligand interacts 
simultaneously with both residues (Figure 15).  

 

Figure 15 - Best conformation of inhibitor designed in situ 56 interacting with Asp1526 and Asp1279 through a 
1,2-diamine functional group 
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Another way to achieve interaction between the ligand and both Asp1279 and 1526 is 
by using 2-(aminoethyl)-aniline group (Figure 16). As the ethyl group allows the amine 
group to be closer to Asp1279 without constraining the docking conformation as much 
as when using the 1,2-diamine benzene ring. 

 

Figure 16 - Ligand designed in situ 73 with a 2-(aminoethyl)-aniline group interacting with both Asp 1279 and 
1526 

The 1,2-diamine benzene ring also presented complementary interaction with residues 
Asp1279 and Asp1420 in numerous times. This interaction (Figure 17) was seen more 
often than the one depicted in Figure 15. 

 

Figure 17 - Best conformation of inhibitor designed in situ 43 interacting with Asp1420 and Asp1279 through a 
1,2-diamine functional group 
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There is also a set of three residues that can be used as a guide for the docking of the 
ligand. However, establishing a simultaneous interaction with all the residues is 
difficult, and the most common result is the interaction between two of these 
residues. The residues referred here are:  Tyr1251, Trp1369 and Arg1377 (Figure 18). 

 

Figure 18 - Position of the residues Tyr1251, Trp1369 and Arg1377 within the active site 

The inhibitor designed in situ number 73 is an example of an inhibitor interacting with 
all the residues through a carboxylic acid functional group (Figure 19). 

 

Figure 19 - Inhibitor designed in situ number 73 interacting with Try1251, Trp1369 and Arg1377 
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The interaction between Tyr1251 and Trp1369 is presented in Figure 20. Ligands that 
can establish interactions with the residues from Figure 18 usually interact with 
Tyr1251 and Trp1369 with an alternative conformation. 

 

Figure 20 - Inhibitor designed in situ number 81 interacting with residues Tyr1251 and Trp1369 

The carboxylic acid group in a different angle also interacts with Trp1369 and Arg1377 
(Figure 21). 

 

Figure 21 - Inhibitor designed in situ number 72 interacting with residues Trp1369 and Arg1377 

The representation style of Figure 15 to Figure 17 and  Figure 19 to Figure 21 is 
different from the other molecular representations as Discovery Studio 3.5 [118]  was 
not capable of correctly opening/interpreting the Vina output files. As such the 
representations were created using PyMol [114]. 

 



Enzymatic inhibitory activity of hydroxycinnamates (HCs). In silico studies 

 

36 

 

Conclusion 

At the end of this work it is possible to reach several conclusions. First, we were able to 
establish that caffeoyl quinic acids and their respective metabolites do not 
demonstrate a proper inhibitory activity towards α-gllucosidase (EC 3.2.1.20). This also 
leads to the conclusion that the positive effects that these compounds exert in diabetic 
patients is therefore reached through one or more alternative mechanisms of action. 
One of such mechanisms may be the interaction with glucose-6-phospate and its 
inhibition [49–51]. The fact that these compounds may also serve as inhibitors for 
other enzymes in the several pathways of the carbohydrate metabolism cannot be 
dismissed. A third mechanism of action is the blockage of the Na+ dependent D-glucose 
transporter. This has been verified in mice with an effect up to 80% with 1mM of 
chlorogenic acid by Welsch et al. [53]. In humans, the effect has been established to 
occur but its extend has not been determined yet, to the best of our knowledge. As 
anti-oxidants, it is quite possible that caffeoylquinic acids alter the cellular chemical 
environment and prevent the naturally occurring reactions. If we consider an 
hydrolysis reaction, it is an oxidation or reduction reaction depending on which 
reactant is considered. It is quite possible that caffeoylquinic acids undergo the 
oxidation process instead of the intended reactant and thus prevent the formation of 
the reaction's regular products. It is also quite possible that all of these mechanisms 
coexist simultaneously and thus provide the outcomes observed in patients treated 
with caffeoylquinic acids/green coffee extract.  

Secondly, the design of and enzymatic inhibitor is extremely difficult. Being able to 
create a ligand that will bind to the required site and interact specifically with the 
intended residues in the way it was designed to requires a lot of trial and error and 
experience. The design of a new ligand from an existing known enzymatic inhibitor is a 
process that should be considered when developing a new inhibitor. Having an 
inhibitor that has known interactions with the target under research makes the initial 
development time of candidates smaller. It also makes it easier to establish 
connections with certain residues if the structural change to the ligand is not very 
extensive. However, it poses a few problems during the design process. First the added 
functionality may completely alter the interactions between the ligand and the 
receptor. The best way to avoid this, as it was discovered throughout this study, is to 
introduce a single functional group change at a time. Another disadvantage of 
optimizing an existing ligand is that the optimization process may improve affinity but 
jeopardizes the drug's usability as it often becomes quite large and stops complying 
with the Lipinski's rules of five. 

Thirdly it is possible to conclude that molecular docking programs, algorithms and 
functions can still be vastly improved to provide more accurate results. Considering the 
results from the acarbose control dockings this becomes even more evident. Despite 
this, their value in providing research guides or priority lists cannot be dismissed. The 
fact that hundreds of ligands can be tested and compared in a very small amount of 
time make computational methods invaluable. In addition, having an experimental 
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result to reproduce through computational methods provides simultaneously a control 
experiment and reduces the limitations in the accuracy of the results obtained. 

On a future work, the interaction between caffeoylquinic acids and all the enzymes in 
the Carbohydrate metabolism should be determined. It is possible that studying the 
inhibition of all these enzymes by caffeoylquinic acids resorting to computational 
methods would help to confirm or exclude and shed some light on currently accepted 
mechanisms of action. It would also provide new insights into the molecular 
mechanisms of the effects that these compounds produce. 
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Naturally occurring Caffeoylquinic acids, derivates and metabolites 

 

Annex 1 - Representation of Inib1 

 

Annex 2 - Representation of Inib2 

 

Annex 3 - Representation of Inib3 
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Annex 4 - Representation of Inib4 

 

Annex 5 - Representation of Inib5 

 

Annex 6 - Representation of Inib6 

 

Annex 7 - Representation of Inib7 
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Annex 8 - Representation of Inib8 

 

Annex 9 - Representation of Inib9 

 

Annex 10 - Representation of Inib10 

 

Annex 11 - Representation of Inib11 
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Annex 12 - Representation of Inib12 

 

Annex 13 - Representation of Inib13 

 

Annex 14 - Representation of Inib14 
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Annex 15 - Representation of Inib15 

 

Annex 16 - Representation of Inib16 

 

Annex 17 - Representation of Inib17 
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Annex 18 - Representation of Inib18 

 

Annex 19 - Representation of Inib19 

 

Annex 20 - Representation of Inib20 
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Annex 21 - Representation of Inib21 

 

Annex 22 - Representation of Inib22 

 

Annex 23 - Representation of Inib23 

 

Annex 24 - Representation of Inib24 
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Annex 25 - Representation of Inib25 

 

Annex 26 - Representation of Inib26 

 

Annex 27 - Representation of Inib27 
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Annex 28 - Representation of Inib28 

 

Annex 29 - Representation of Inib29 

 

Annex 30 - Representation of Inib30 
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Annex 31 - Representation of Inib31 

 

Annex 32 - Representation of Inib32 

 

Annex 33 - Representation of Inib33 
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Annex 34 - Representation of Inib34 

 

Annex 35 - Representation of Inib35 

 

Annex 36 - Representation of Opt1 
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Annex 37 - Representation of Opt2 

 

Annex 38 - Representation of Opt3 

 

Annex 39 - Representation of Opt4 
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Annex 40 - Representation of Opt5 

 

Annex 41 - Representation of Opt6 

 

Annex 42 - Representation of Opt7 
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Annex 43 - Representation of Opt8 

 

Annex 44 - Representation of Opt9 

 

Annex 45 - Representation of Opt10 
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Annex 46 - Representation of Opt11 

 

Annex 47 - Representation of Opt12 

 

Annex 48 - Representation of Opt13 
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Annex 49 - Representation of Opt14 

 

Annex 50 - Representation of Opt15 

 

Annex 51 - Representation of Opt16 
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Annex 52 - Representation of Opt17 

 

Annex 53 - Representation of Opt18 

 

Annex 54 - Representation of Opt19 
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Annex 55 - Representation of Opt20 

 

Annex 56 - Representation of Opt21 
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Ligands designed in situ 

 

Annex 57 - Representation of Insitu1 

 

Annex 58 - Representation of Insitu2 
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Annex 59 - Representation of Insitu3 

 

Annex 60 - Representation of Insitu4 
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Annex 61 - Representation of Insitu5 

 

Annex 62 - Representation of Insitu6 
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Annex 63 - Representation of Insitu7 

 

Annex 64 - Representation of Insitu8 

 

Annex 65 - Representation of Insitu9 
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Annex 66 - Representation of Insitu10 (the three dimensional structure of this ligand had no rotatable bonds) 

 

Annex 67 - Representation of Insitu11 (same molecule as Insitu10 but with all bonds being rotatable) 
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Annex 68 - Representation of Insitu12 

 

Annex 69 - Representation of Insitu13 
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Annex 70 - Representation of Insitu14 
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Annex 72 - Representation of Insitu16 

 

Annex 73 - Representation of Insitu17 
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Annex 74 - Representation of Insitu18 

 

Annex 75 - Representation of Insitu19 
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Annex 76 - Representation of Insitu20 

 

Annex 77 - Representation of Insitu21 
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Annex 78 - Representation of Insitu22 

 

Annex 79 - Representation of Insitu23 
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Annex 80 - Representation of Insitu24 

 

Annex 81 - Representation of Insitu25 
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Annex 82 - Representation of Insitu26 
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Annex 85 - Representation of Insitu29 
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Annex 87 - Representation of Insitu31 
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Annex 89 - Representation of Insitu33 
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Annex 91 - Representation of Insitu35 
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Annex 93 - Representation of Insitu37 
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Annex 95 - Representation of Insitu39 
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